
The Bytes of Las Vegas
_______________________________________________________________________________________________
____

November, 2010

NEXT GENERAL MEETING

Date: Wednesday, December 1, 2010

Time: 5:00-6:45 PM (NOTE NEW TIME)

Place: West Charleston Library 6301 W Charleston

Please contact http://www.lvpcug.org for latest information.

INDEX
 Important Message      1

Announcements            2

Meeting Info                  3

Membership                  4

APCUG News               5

Buy Sell Trade             6

Smart Computing        7

Misc. Web sites            8

Free Utilities                 9

Continued  From p 9   10

SIG’s Calendar             11

Membership Form        12

New Notice to Members:

The Executive Board has decided to reduce the frequency
of General Meetings from monthly to quarterly because
of the difficulty in getting presenters, and because of low
attendance. Meetings are scheduled for December 1st,
2010, March 2nd, 2011, June 1st, 2011, September 7th,
2011, and December 7th, 2011. The frequency of board
meetings is also reduced, so they occur in the month just
prior to the general meeting.

 The Bytes of Las Vegas will decrease in the number of times it
will be posted to the web site. More information to follow at a
latter date.

The subject and the presenter will be announced at the Dec 1st
meeting.

http://www.lvpcug.org
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Announcements

The Special Interest Groups (SIG) will be
meeting at their regular times. Be sure to check
the calendar on the web site. We are looking for
a new place for our General meetings and SIG's.
If you have any suggestions, please email us at
info@lvpcug.org

Check the web site at http://www.lvpcug.org for
the calendar dates and times.

Would you like to share a computer talent you
have or would be interested in learning about a
certain topic. We would appreciate your ideas!

RECYCLING BRINGS REWARDS The LVPCUG is
receiving rebates for recycling ink

cartridges, toner cartridges and cell
phones. The Recycling Committee urges
members to set aside those items and

bring them to the general meeting. You
might also spread the word to family
members and friends to save them for
you too. There is not cost to the

club,only your time in gathering the
material and the committee members
'time to package it.If you have any
questions, please see Charles Finnila
at the General Meeting at the West

Charleston Library.

Board of Directors

Wendy Jaroslawski President

Harold Rozinski Vice President

Joyce Shore Treasurer

Robert Lynch Secretary

Judy Ruf Executive Director

Larry Burgher Technical Director &

Webmaster

Linda DiGiovanni SIG Coordinator

Charles Finnila Recycling Chairman

Leland Beel Bytes of Las Vegas Editor

& Little Bytes Editor

Officers and Volunteers Contact by sending an email to info@lvpcug.org

Membership Questions If you have any questions about your membership.

Please send email: membership@lvpcug.org

Web site: http://www.lvpcug.org
Membership
$30 per year. Dues are collected
Annually from your membership date. If you
would like to join, a membership form is located
at the end of the newsletter. Please complete and
forward to our mailing address. Las Vegas PC
Users Group, Inc. 1350 E. Flamingo Rd# 188

Las Vegas, NV 89119

Newsletter

The Bytes of Las Vegas is published on a month basis.

A PDF version is available to members online at the
web site.

Information in the newsletter was obtained from
sources considered to be reliable. Accuracy and
completeness are not guaranteed.
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NEXT GENERAL MEETING : WEDNESDAY Dec 1st

 TIME: 5:00 - 6:45 PM

PLACE: WEST CHARLESTON LIBRARY

6301 W CHARLESTON BLVD (East of Torrey Pines)

We are looking for a space to conduct an informational demo
about LVPCUG.  If you know of any place that is available to conduct
a demo about the Club Please contact Judy Ruf  or send email to:
info@lvpcug.org   Needed are a table space some chairs and an
electrical outlet to plug in a laptop computer.

Attend a meeting and you have a chance to win a door prize from the drawing at the
end of the meeting,  Door Prize winners from the November 3 meeting were Marilyn
Mills won a software package called Adobe PhotoShop Album,  Rogert Ward won a
software package called OmniPage and Raymond Wagner won a book on Digital
Photography.

THIS SPACE AND MORE IS RESERVED FOR

A NOTE, HINT, COMMENT OR OTHER WISE

FROM THE MEMBERSHIP OF THE

LAS VEGAS PC USER GROUP

THANKS THE EDITOR

Abraham Lincoln once said, “The dogmas of the quite past
are inadequate to the stormy present.  The occasion is piled
high with difficulty, and we must rise with the occasion.”

For those members who use Cartridge World for their printer consumables, please note that their store
formerly in the Home Depot shopping center at Rainbow and Charleston has moved to 3655 S Rainbow
Suite 104 in the Walmart shopping near Spring Mountain. Thanks to Karl Rehak for discovering this.
Their other store is still at 9550 S Eastern Ave, Suite 190.

When Your Computer Has
You Really Frustrated.
This is a new Key not
found on your Keybd.

info@lvpcug.org
http://info@lvpcug.org
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Membership Corner
  Member dues help the club pay bills such as liability insurance, Clear Internet service,
web site fees, APCUG membership, equipment, meeting room rent, and raffle prizes.  It is
important that members be always on the lookout for a perspective new member.

 Welcome new members James and Joyce Wainscott, who have been attending our Novice
SIG. We hope to meet you James and Joyce at our next General Meeting on December lst.
Members if you use online banking you can send your renewal fast and easy by letting the
bank do the work and pay for the postage. Our club information is Las Vegas PC Users
Group, 1350 E. Flamingo Rd. #188, Las Vegas, NV 89119.

New Notice to Members:

The Executive Board has decided to reduce the frequency of General Meetings
from monthly to quarterly because of the difficulty in getting presenters, and
because of low attendance. Meetings are scheduled for December 1st, 2010,
March 2nd, 2011, June 1st, 2011, September 7th, 2011, and December 7th, 2011.
The frequency of board meetings is also reduced, so they occur in the month
just prior to the general meeting.

The number of The Bytes of Las Vegas posted to the web site will decrease in
number, more information at a latter date.

Three non-board member volunteers are needed for the election committee.
Duties are easy. Contact a board member for details.

The Best Antivirus Software for 2011

http://www.pcmag.com/article2/0,2817,2372364,00.asp

Thanks Charles F.
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If you are a member of LVPCUG that means
you are a member of APCUG and you have a
great opportunity to use the resources
that they provide. Such as the calendar
that members may log in and view a
meeting of a different club or SIG and
see what they are doing. Please go to
www.apcug.org and create a users account
in the APCUG SharePoint Site so that you
can enjoy some of the benefits of
membership in the LVPCUG and its shared
portals.

Here is your funny Picture from AhaJokes.com

Live Meeting Training for  Dec 13, and Dec 18

The URL for the Live Meeting Training for Mon, Dec 13 10pm EDT, 9pm CDT, 8pm MDT, 7pm PDT is here.
Before you attend you will need to have downloaded the client from here and checked to be sure it is working
here
The URL for the Live Meeting Training for Sat, Dec 18 5pm EDT, 4pm CDT, 3pm MDT, 2pm PDT is here.
Before you attend you will need to have downloaded the client from here and checked to be sure it is working
here
“Here” in the above article is referring to the www.apcug.net web page with the information about the
Live Meeting Training information. This will be a direct link to the proper information.

Send To

The SEND To menu in Windows 7 offers some hidden options

That make managing files more convenient.  Just Hold down
the SHIFT key while right clicking on an item and you will see
an expended SEND To menu that displays all of your personal
account folders, including MY Documents, MY Music, My
Pictures, My Videos etc.  This is a neat since I have always been
A big user of the right click and Send To.

Thanks to Linda Nelson

“People think computers will keep them from making mistakes. They're wrong. With
computers you make mistakes faster.”
Adam Osborne
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LAS VEGAS PC USERS GROUP

 Buy, Sell or Trade  This is a new section for the Members

Item name and description, what is wanted to do with item, price or
other terms
Persons: Name,Phone number if desired and or an email address to
contact the person placing the Ad in The Bytes of Las Vegas.

The Ad will run for 3 months and then will be discontented unless the
request is resubmitted for one time more.

??? No commercial ads to be run for free?? Subject to editors space and
time.
Please Contact the Editor by sending an email to: editor@lvpcug.org

  by the 15th of the month.

Keyboard Manager (Fellowes), under desk, fully adjustable both height and
tilt, gel wrist rests, gliding mouse pad. New, never used, still in box. $35.
Email:  mcmxx@embarqmail.com.  Phone:702-361-6363.   M. Mills

Date ad Started

10, 2010

http://editor@lvpcug.org
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• Take A Shortcut In Excel: If you use Excel frequently, you're probably already familiar with many
basic Excel keyboard shortcuts. However, there are some little-known shortcuts that can help you work
even more efficiently in selecting ranges and moving around a worksheet. For example, you can quickly
select an entire data region (a range of data cells bordered by empty cells) by clicking one of the cells and
then holding down CTRL-SHIFT-* (asterisk). Another way to select a data range is to place your cell
pointer in the range and then press CTRL-A; press CTRL-A a second time to select the entire worksheet.
You can also press CTRL-Spacebar to select the column where your cell pointer is located. Another
helpful keyboard shortcut is to press END followed by an Up, Down, Left, or Right arrow key to
efficiently move the cell pointer to the outermost edge of a data range.

• Skip A Bullet Or Number In Microsoft Word: There can be times when you're working with a bulleted
or numbered list when you want to add a new line without tacking on a number or bullet. Perhaps you
want to add a parenthetical note below an entry without making it part of your list. If you hold SHIFT
and press ENTER, Word will add a new line to your list without a bullet a number. When you want to
resume numbering or bulleting, don't hold the SHIFT key any longer.

• Save The Page: If you're using Internet Explorer and you come across a Web page with information you
want to preserve, there are two good ways to keep the information without having to use a Web browser
to bring it back up. The first and simplest way is to print it; it never hurts to have a hard copy of
information you need. Another method is to save the Web page as an .MHT (Multipurpose Internet Mail
Extension) file, which is essentially just a snapshot of the page. In this format you can send the page to
others or double-click on it to open it directly. To make a .MHT file from a Web page, click File (press the
ALT key to reveal the File menu if you don't see it), click Save As, and in the dialog box be sure to select
the .MHT file type. Tell the computer where to put the file and click Save.

• IE 8 Tabs: Did you just close Internet Explorer 8 when you meant only to close a tab? Oops. Tabbed
browsing can be a hazard if the wrong settings are in place. First, don’t despair. As soon as you recognize
the error, restart IE and, in the Tools menu, click Reopen Last Browser Session. In many cases, this will
save your set of open tabs on the last IE window you had open. To keep this from happening again, use
the Tools menu to access Internet Options. In the Tabs section on the General tab, click Settings.
Checkmark the Warn Me When Closing Multiple Tabs box.

"Reprinted with permission from Smart Computing. Visit www.SmartComputing.com/groups to learn
what Smart Computing can do for you and your user group!"
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Social Networking Virus Infects Macs, PCs

http://www.infopackets.com/news/security/2010/20101029_social_networking_virus_infects_macs_pcs.htm

File-Sharing Service LimeWire Shut Down for Good

http://www.infopackets.com/news/piracy/2010/20101028_file_sharing_service_limewire_shut_down_for_good.
htm

HP Slate 500: Win7 Tablet PC Available Friday

http://www.infopackets.com/news/hardware/2010/20101028_hp_slate_500_win7_tablet_pc_available_friday.
htm

Shame shame: Decade's 10 biggest tech scandals

http://content.techrepublic.com.com/2346-12850_11-481657.html?tag=nl.e055

Pastor to married church leaders: Thou shall not Facebook

http://www.zdnet.com/blog/btl/pastor-to-married-church-leaders-thou-shall-not-facebook/41824?tag=nl.e539

From cuniform to flash - a history of storage (photos)

http://www.zdnet.com/photos/from-cuniform-to-flash-a-history-of-storage-photos/482136

I'm switching to a Mac. Here's how (and why)

http://www.zdnet.com/blog/bott/im-switching-to-a-mac-heres-how-and-why/2620?tag=nl.e539

Hands-on with the B&N Nook Color; an excellent color ebook reader

http://www.zdnet.com/blog/mobile-gadgeteer/hands-on-with-the-b-n-nook-color-an-excellent-color-ebook-
reader/4110?tag=nl.e539

Introducing Comac, China’s answer to Boeing and Airbus

http://www.smartplanet.com/technology/blog/thinking-tech/introducing-comac-chinas-answer-to-boeing-and-
airbus/5669/

Google Apps is a suite of online applications.  It includes email, word processing, spreadsheets, your own
website and storage.  Free for 30 days and $5/mo. after.  Sure beats paying $200 to $400 to put it on your hard
drive!

30 Day free Trial   Got to www.google.com/apps/free30

Thanks LB and RL
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Free Utilities from CPUID Describe System Details
by Ira Wilsker

WEBSITES:
http://www.cpuid.com
http://www.cpuid.com/softwares.html

 As regular readers of this column know, I am a fan of utilities, especially if they are free!  Fre-
quently, situations arise where it is necessary to know the details of a computer, including specifics
about its software, hardware, drivers, and other components in order to diagnose a problem and make
recommendations.  There are several fine utilities that can perform these functions, but several that I
have been using recently come from the historical city of Dunkerque, France, courtesy of their publish-
er CPUID Software.
 CPUID software is best known for its namesake product, CPUID, which is as it says, a utility to
identify the details of the CPU chip installed in a computer.  This is often necessary to know if the com-
puter is being benchmarked (performance measured), upgraded, or undergoing major repairs.  The
latest CPUID software is named CPU-Z, version 1.55.  This small utility displays the processor brand
and model number, the type of socket it uses (necessary to know for replacement or upgrades),
speeds, and other details about the CPU chip, which is the central "brains" of the computer.  Some-
times it is desirable or necessary to replace a motherboard, or determine the BIOS on the mother-
board.  The motherboard is the central platform on which most of the other internal components are
either directly attached to, or otherwise connected to, and provides much of the internal communica-
tion between the components.  While generally very reliable and long lived, sometimes it is necessary
to replace a motherboard.  The BIOS, an acronym for "Basic Input - Output System" is typically at-
tached to the motherboard, and contains the first code run by a PC when it is initially powered on.
The BIOS identifies and initializes the video card, keyboard, mouse, hard drive, CD/DVD drive, and
other key components.  The BIOS contains software in a non-volatile ROM chip, and is typically firmly
attached to the motherboard.  Most BIOS chips can be updated and upgraded with software provided
either by the BIOS manufacturer, motherboard maker, or computer manufacturer.  CPU-Z identifies
the brand of BIOS, the version of its software, and the date of the software stored in it; with this infor-
mation, it is somewhat easy to determine if the BIOS contains the latest software.  Keeping the BIOS
updated is not a critical task if everything appears to be working OK, but for those of us always trying
to tweak our computers and capitalize in the latest offerings, this is good information to have.  One
warning is appropriate here; if the user is considering updating the BIOS, be absolutely sure to explic-
itly follow the manufacturer's directions to the letter!  In a worst case scenario, failure to do so will re-
sult in an expensive paperweight, but in many cases, there is a procedure to "roll back" or restore the
BIOS to its earlier status.
 When I ask people how much memory they have in their computer, they are often clueless, or
erroneously confuse the memory with the storage capacity of their hard drives.  Clicking on the
"Memory" tab of CPU-Z displays the type of memory, the amount of memory, speed, and other char-
acteristics.  The "SPD" tap allows the user to cycle through the memory stick installed in his computer,
displaying the capacity of each stick, the type, manufacturer, part number, and other information.  This
information may be necessary if the user wants to add or replace memory in the computer.

Continued on Page 10
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Continued from Page 9

The "Graphics" tab displays information about the display device, including the brand, model number,
chipset, speed, and memory.  Since the video card makers often release updates, enhancements,
and new features, this information could be very useful.
 CPUID also publishes several other utilities, and another one that I found useful is PC Wizard
2010.  PC Wizard was first published in 1996, and is considered one of the most comprehensive sys-
tem information utilities available.  Since the hardware industry is very dynamic, with new hardware
being introduced on a daily basis, PC Wizard is frequently updated, typically monthly.  In addition to
identifying and displaying the details of the hardware and software on the computer, PC Wizard can
also benchmark the performance of the individual computer components, as well as the entire com-
puter.  By noting which components and software are the performance laggards, the user can then
determine what, if any, practical solutions may improve performance.  PC Wizard utilizes a series of
icons representing each of the components or software titles installed on the computer, and can de-
termine the hardware, configuration, system files, and resources used by the computer.  The bench-
mark selection can test and display the performance of the entire computer, the CPU (processor
chip), memory, video, hard drive, external storage devices (like CD/DVD and USB drives), and other
hardware components.  In addition to displaying the performance of the hardware itself, a "Compare
Results" shows how the user's computer compares to others.  The results are also displayed and an-
nounced (audio) using the wizard avatar and voice synthesis similar to the "Vox Proxy" PowerPoint
accessory.  PC Wizard provides the user with a wealth of information.
 While CPUID has several utilities available for free download, one of those that I also found
very useful is HWMonitor, which is a shortened "Hardware Monitor".  This utility is also available in an
enhanced commercial version, HWMonitor Pro, which adds additional features and functionality.
HWMonitor (the free version) can identify the power supply in the computer, and display the real-time
voltages, temperatures, and fans in the power supply.  This is important to monitor the health of the
power supply, and consider a replacement or upgrade if necessary.  Many users are unaware that
their computers report the temperatures of various components in the computer, which is important in
that heat is one of the big killers of components.  Being somewhat colonial, I selected to display the
temperatures in Fahrenheit (F) rather than Celsius (C).   Usually there are some fans in each comput-
er which are critical in exhausting the heat from the components, and bring in cool outside air.  HW-
Monitor tracks and reports the performance of the fans, which can enable the user to easily and
quickly see if a fan is failing; a dead fan can lead to overheating and damage or destruction of the
computer's components.  This utility can also track and report on the temperatures of the mother-
board, CPU chip, video card, and hard drive.
 Most of these utilities are available for 32 and 64 bit Windows PCs using recent versions of
Windows such as XP, Vista, and Windows 7, although some of the utilities also have builds that are
explicitly for Windows 98.  The files are relatively small and fast to download, and consume minimal
system resources, such that they do not noticeably degrade system performance.  These utilities
could be a useful asset to anyone who wants to keep up with the performance, condition, and health
of his system.

Thanks APCUG
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SIG’s MONTHLY CALENDAR
SIG NAME MEETING DATE PLACE TIME OF MEETING SIG LEADER

Helping Hands 1st Saturday  #1 10 AM TO 4 PM Linda
395-6676 DiGiovanna

Windows Developers On hold till a meeting room can be found

Novice(new users) 2nd Saturday #1 1 PM TO 3 PM Chuck

And Internet 452-9440 Frederick

Software and 2nd Saturday         #1 3:30 PM TO 5:30 PM Linda

Product Review 395-6676 DiGiovanna

Digital Imaging 2nd Sunday            #1 12 TO 2 PM Howard

262-3662 Mark

LINUX/Open Source 3rd Saturday    #1  1 PM TO 3 PM

Need a SIG Leader for a period of time till Don can come back

How-To-Workshop 4th Saturday    #2  9:30 TO 2:30 PM Dennis

Kemper

Places are:

#1 Wengert Room is located in the back of the NV Energy building just west of Jones on
W. Sahara

#2 Paseo Verde Library is located in Henderson at 280 S. Green Valley Parkway.

All meetings Are Subject to Cancellation by the SIG Leader or the Property Owner. The
Calendar Page of the LVPCUG web site is keep as current as possible.

If you would like to be a SIG Leader for some of the SIG’s that are not meeting at this
time, Please Contact Wendy to get the details of the duties of the Leader. You may leave a
email at info@lvpcug.org
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Las Vegas PC Users Group, Inc.

Membership Application
New Members or Renewal with Information Changes

To join the Las Vegas PC Users Group, pleas complete the information form below. The
form can be mailed with a check or brought to the General Meeting. Dues are $30 per
year per family. More information about the Club can be obtained at : www.lvpcug.org
Date__________________________       NEW ______________      RENEWAL _______________________

Please Print)

Name (1)___________________________________ Name (2)____________________________________

Email (1)___________________________________ Email (2)____________________________________

Address:_________________________________________________________________________________

City_________________________________________ State _______ Zip_______________________

Phone:_________________________ Cell Phone:______________________ Fax:___________________

It is LVPCUG policy to keep your information confidential.

Supplemental information (optional, but helpful)

How did your hear about LVPCUG?_____________________________________________

____________________________________________________________________________

Area of Interest: _____________________________________________________________

Send Check for $30 to: Las Vegas PC User Group

Membership Director

1350 E. Flamingo Rd #188

Las Vegas, NV 89119-5270

Club Use only: Membership No.______________________ Rec’d___________________

Amount __________________________ Method _______________________________

http://www.lvpcug.org

